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Contact Information

Customer support and sales contacts
Quality, technology, and service are the hallmarks of Pacifi c Crest. We 
provide easy access to our customer service department to keep you 
running effi  ciently.

Support hours are 8 am to 5 pm Pacifi c Time. Please visit our website for 
up-to-date news and product announcements. Firmware and software 
upgrades are available from our website, usually free of charge. 

Legal notices
©2012 Pacifi c Crest. All rights reserved. Adaptation, or translation of 
this manual is prohibited without prior written permission of Pacifi c 
Crest, except as allowed under the copyright laws. Th is document 
contains proprietary information that is protected by copyright. All 
rights reserved. Th e information contained in this document is subject 
to change without notice. 

Trimble is a trademark of Trimble Navigation Limited, registered in 
the United States and in other countries. TRIMMARK and TRIMTALK 
are trademarks of Trimble Navigation Limited. Microsoft, Windows, 
and Windows Vista are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. All 
trademarks are the property of their respective owners. 

Warranty
PACIFIC CREST MAKES NO WARRANTY OF ANY KIND WITH REGARD 
TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. Pacifi c Crest shall not be liable for errors contained herein or 
for incidental consequential damages in connection with the furnishing, 
performance, or use of this material. 

Warranty

One-Year limited warranty
Th is warranty gives you specifi c legal rights. You may also have other 
rights which vary from state to state or area to area.

Pacifi c Crest warrants ADL family products, inclusive of cables and 
batteries, against defects in materials and workmanship for a period of 
one year from receipt by the end-user.

Exclusions
Should Pacifi c Crest be unable to repair or replace the product within a 
reasonable amount of time, a refund of the purchase price may be given 
upon return of the product.

Th e warranty on your radio shall not apply to defects resulting from:

• Improper or inadequate maintenance by the customer

• Unauthorized modifi cation, negligence, or misuse

• Operation outside of the environment specifi cations

Warranty limitations
Th is warranty set forth above is exclusive and no other warranty, 
whether written or oral, is expressed or implied. Pacifi c Crest specifi cally 
disclaims the implied warranties of merchantability and fi tness for a 
particular purpose.

Notices
Class B Statement – Notice to Users. Th is equipment has been tested and 
found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC rules. Th ese limits are designed to provide reasonable 
protection against harmful interference in a residential installation. 
Th is equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communication. However, there is 
no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off  and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and the receiver.

• Connect the equipment into an outlet on a circuit diff erent from that 
to which the receiver is connected.

• Consult the dealer or Pacifi c Crest directly for help.

Changes and modifi cations not expressly approved by the manufacturer 
or registrant of this equipment can void your authority to operate this 
equipment under Federal Communications Commission rules.

Canada
Th is digital apparatus does not exceed the Class B limits for radio noise 
emissions from digital apparatus as set out in the radio interference 
regulations of the Canadian Department of Communications.

Le présent appareil numérique n’émet pas de bruits radioélectriques 
dépassant les limites applicables aux appareils numériques de Classe B 
prescrites dans le règlement sur le brouillage radioélectrique édicté par 
le ministère des Communications du Canada.

Europe
Th is product has been tested and found to comply with the requirements 
for a Class B device pursuant to European Council Directive 1999/5/
EC on R&TTE, thereby satisfying the requirements for CE Marking and 
sale within the European Economic Area (EEA). Th ese requirements are 
designed to provide reasonable protection against harmful interference 
when the equipment is operated in a residential or commercial 
environment, and to ensure that the equipment is safe.

Australia and New Zealand
Th is product conforms with the regulatory requirements of the 
Australian Communications and Media Authority (ACMA) EMC 
framework, thus satisfying the requirements for C-Tick Marking and 
sale within Australia and New Zealand. 

Notice to Our European Union Customers
For product recycling instructions and more information, please go to 
www.trimble.com/ev.shtml. 

Recycling in Europe: To recycle Trimble WEEE (Waste Electrical and 
Electronic Equipment, products that run on electrical power.), Call +31 
497 53 24 30, and ask for the “WEEE Associate”. Or, mail a request for 
recycling instructions to:

Trimble Europe BV
c/o Menlo Worldwide Logistics
Meerheide 45
5521 DZ Eersel, NL

Headquarters
Pacifi c Crest

510 DeGuigne Drive

Sunnyvale, CA 94085

U.S.A

Tel: 1-800-795-1001 (U.S.A toll free)

+1-408 481-8070 (outside the U.S.A)

Fax: +1-408 481-8984

Sales email: sales@Pacifi cCrest.com

Support email: support@Pacifi cCrest.com

Repair info: pccservice@Pacifi cCrest.com

Web www.Pacifi cCrest.com

EMEA Offi ce
HAL Trade Center

Bevelandseweg 150

1703 AX Heerhugowaard

Th e Netherlands

Tel: +31-725-724-408

Fax: +31-725-348-288

March 2012
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  Safety Information
Before you use your radio, ensure that you have read and understood this publication, as 
well as safety requirements.

CAUTION – A license is required before operating radio communication equipment.

 Warnings and cautions
An absence of specific alerts does not mean that there are no safety risks involved.

Always follow the instructions that accompany a Warning or Caution. The information 
they provide is intended to minimize the risk of personal injury and/or damage to the 
equipment. In particular, observe safety instructions that are presented in the following 
formats:

WARNING – A Warning alerts you to a likely risk of serious injury to your person and/
or damage to the equipment. A warning identifies the nature of the risk and the extent 
of possible injury and/or damage. It also describes how to protect yourself and/or the 
equipment from this risk. Warnings that appear in the text are repeated at the front of the 
manual.

CAUTION – A Caution alerts you to a possible risk of damage to the equipment and/or loss of 
data. A Caution describes how to protect the equipment and/or data from this

 Exposure to radio frequency energy
The radio is designed to comply with the following national and international standards 
and guidelines regarding exposure of human beings to radio frequency electromagnetic 
energy, in addition to protection against harmful interference of neighboring electrical 
equipment:

• FCC Report and Order FCC 96-326 (August, 1996)

• American National Standards Institute (C95.3-1992)

• National Council on Radiation Protection and Measurement (NCRP - 1986)

• International Commission on Non-ionizing Radiation Protection (ICNRP - 1986)

• European Committee for Electrotechnical Standardization (CENELEC)

• FCC CFR47 Part 15

• FCC CFR47 Part 90

• Industry Canada RSS 119

• ETSI EN 300 113-2

• ETSI EN 300 489

• ACA AS/NZS 4295

• iDA Spec 111

• OFTA STD-1E

• RRC CMII
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Contact your sales representative for model specific country approval.

To assure optimal radio performance and to ensure that exposure to RF energy is within 
the guidelines in the above standards, observe the following operating procedures:

• Do not operate a transceiver when someone is within the distance noted below of 
the antenna (unity gain). 

 – 30 cm (approximately 12 in) for the ADL Sentry radio @ 2 W 

 – 60 cm (approximately 2 ft) for ADL Sentry @ 4 W

 – 15 cm (approximately 6 in) for the ADL Sentry radio @ 1 W

• Do not operate the transceiver unless all RF connectors are secure and any open 
connectors are properly terminated.

• Avoid contact with the antenna while operating the transceiver.

• Do not operate the transceiver with a damaged antenna. If a damaged antenna 
comes in contact with the skin, a minor burn may result.

• Do not operate the equipment near electrical blasting caps or in an explosive 
atmosphere.

• Antennas are excellent conductors of electricity, so use extreme caution when 
operating near power lines and other sources of electric current or during stormy 
weather.

CAUTION – Changes or modifications not expressly approved by the FCC could void the user’s 
authority to operate the equipment.

  Rechargeable batteries
The radio uses a 12 V, deep-discharge, lead-acid battery (portable power battery).

CAUTION – Storing batteries for an extended time in a discharged state damages them. 

Note – For specific safety information, refer to the documentation included with your battery.

WARNING – Do not damage the battery. A damaged battery can cause an explosion or fire, 
and can result in personal injury and/or property damage. To prevent injury or damage: 

• Do not use or charge the battery if it appears to be damaged. Signs of damage include, 
but are not limited to, discoloration, warping, and leaking battery fluid.

• Do not expose the battery to fire, high temperature, or direct sunlight. 
• Do not immerse the battery in water. 
• Do not use or store the battery inside a vehicle during hot weather. 
• Do not drop or puncture the battery. 
• Do not open the battery or short-circuit its contacts.

WARNING – Avoid contact with the battery if it appears to be leaking. Battery fluid is 
corrosive, and contact with it can result in personal injury and/or property damage. To 
prevent injury or damage:

• If the battery leaks, avoid contact with the battery fluid. 
• If battery fluid gets into your eyes, immediately rinse your eyes with clean water and seek 

medical attention. Do not rub your eyes! 
• If battery fluid gets onto your skin or clothing, immediately use clean water to wash off 

the battery fluid.
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WARNING – Charge and use the rechargeable battery only in strict accordance with 
the instructions. Charging or using the battery in unauthorized equipment can cause an 
explosion or fire, and can result in personal injury and/or equipment damage. To prevent 
injury or damage: 

• Do not charge or use the battery if it appears to be damaged or leaking.
• Charge the battery only in a Trimble product that is specified to charge it. Ensure that you 

follow all instructions that are provided with the battery charger. 
• Discontinue charging a battery that gives off extreme heat or a burning odor.
• Use the battery only in Trimble equipment that is specified to use it. 
• Use the battery only for its intended use and according to the instructions in the product 

documentation.

CAUTION – Do not use any battery charger as a power supply for any radio. This may damage 
the radio. Do not recharge any battery while it is connected to a radio.

Tranmission Rules and Regulations

 Licensing requirements

It is the responsibility of the owner to comply with applicable rules and regulations 
concerning the operation of a radio transmitter. In the United States, the FCC regulates 
the licensing of this equipment.  The ADL Sentry transceiver uses extended frequencies 
and may contain functions that are not operational in the United States and its 
territories. Users should check with the radio authority of the country of operation for any 
restrictions that might apply.

Application for a license is made by submitting FCC Form 600 along with evidence of 
frequency coordination (if required) and applicable fees. Similar licensing requirements 
exist worldwide. Penalties for broadcasting without a license can be severe, and may 
include the confiscation of your radio.

For more information, contact our customer service department. 

WARNING: Always obey local licensing requirements and restrictions. It is illegal to transmit 
in the United States while CSMA is turned off. CSMA is not required within the European 
Union and should be turned off.

 Equipment compliances

The radios have been tested and found to comply with Parts 15 and 90 of Title 47 of the 
Code of Federal Regulations. They have also been tested and found compliant for type 
certification and approval in many other countries worldwide.

For more information concerning our worldwide compliances, contact customer support.

 Being part of the RF community

Operation of a licensed radio product makes you a member of the RF community. 
Be aware that virtually all frequencies licensed are provided on a shared basis with 
other users. Each frequency dedicated specifically to RTK surveying activities has 
certain restrictions and limitations. For complete information, refer to the appropriate 
documentation from the licensing agency in your country of operation, e.g., Part 90, Title 
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47, of the Code of Federal Regulations.

Most frequencies sharing data transmissions and voice transmissions give priority to voice 
users. Be mindful of the persistent nature of a GPS RTK data transmission and always limit 
your RF transmission output power when performing close-in survey situations to avoid 
interference with co-channel users. Pacific Crest recommends using the low RF power 
setting for construction site and other line-of-site surveys with baselines less than two miles 
(depending on terrain).

WARNING: If you are in conflict with a co-channel user, select another frequency to avoid 
formal actions by government agencies. In most cases, you are required to vacate a frequency 
upon complaint by a shared channel voice user.

Most survey operations are itinerant in that the system is moved on a frequent basis. For 
fixed system installations, you should not use frequencies set aside for itinerant operations, 
but should coordinate a frequency based on the fixed area operation.

Regulations differ from country to country, please be aware of the local regulations before 
using radio equipment.

 Automatic station identification

For operation in the United States, the FCC requires that radio transmitters broadcast a 
station identifier every 15 minutes. The station identifier is the call sign assigned to you on 
the station license.

The radios support the broadcast of station identification in a manner that meets the 
requirements of the FCC. Upon receipt of equipment, use the ADLCONF software to program 
your FCC call sign into the configuration of the radio. This is only required for transmitters.

The call sign is transmitted every 15 minutes in Morse code. It is not included in any 
data packet and so is not processed by the receiving radio. However, data transmission is 
interrupted for a few seconds while the call sign is being transmitted. If you leave the Call 
sign field blank (on the ADLCONF’s Identification screen), the radio programmed with this 
configuration file will not transmit any call sign.

WARNING: Failure to transmit your station identification is in violation of FCC regulations. 
If you are operating outside the United States, check with the local authorities if you need to 
transmit a call sign.

 Carrier Sense Multiple Access (CSMA)

CSMA is a technology implemented in the radios to meet the United States Federal 
Communication Commission (FCC) transmitter requirements. It is illegal to transmit on any 
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UHF radio within the United States without CSMA enabled. CSMA holds off the radio 
transmission if the frequency is currently being used by a co-channel user. On occasion, 
you may note that the radio broadcasts stop for short periods of time. Most often, this 
is a case of co-channel interference and the radio is holding off broadcasts due to the 
FCC-mandated CSMA.

Note – You should turn CSMA off when transmitting within the European Union.

GPS RTK equipment is designed to function with intermittent gaps in the data. Heavy 
co-channel use may limit the ability of the radio to transmit the required information. In 
areas of heavy co-channel usage, try changing channels to a less used frequency.
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 Introduction
This manual describes how to set up and use the Advanced Data Link (ADL) Sentry radio, 
model numbers ADLS-1 (390-430 MHz) and ADLS-2 (430-470 MHz). 

 The ADL Sentry is an advanced, high speed, wireless data link that is designed specifically 
for environmental monitoring applications. Your success in using the radios is Pacific 
Crest’s primary goal. Pacific Crest stands behind its products by providing expert support 
and service. Your comments and questions are welcome.

This guide is written for the first-time user and gives details concerning system setup, 
operation, and maintenance. We urge you to take the time to review this short manual 
completely before you set up the system.

 Note about this guide
We believe that the ADL Sentry system provides the best value and performance for the 
user. As such, we provide our equipment in complete turnkey systems, including all of the 
items necessary for operation with your GPS.

You may have purchased this radio from a third-party supplier. On occasion, the bundled 
product provided by these sources may differ from the kits provided directly from Pacific 
Crest. If this guide does not accurately reflect the equipment that you received, please 
contact your supplier for specific instructions concerning the setup of items that differ.

 Technical Support
If you have a problem and cannot find the information you need in the product 
documentation, contact your local dealer or go to the Support area of the Pacific Crest 
website (www.pacificcrest.com/support.php). Product updates, documentation, and any 
support issues are available for download.

If you need to contact technical support, email support@pacificcrest.com. 

 Your Comments
Your feedback about the supporting documentation helps us to improve it with each 
revision. Email your comments to  info@pacificcrest.com.
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 Overview

Features

Compatibility

• Facilitates radio equipment mix and match

• Interoperable with Pacific Crest (RFM, PDL, and ADL), SATEL ®, and Trimble® radio 
products

• All models support 12.5 kHz and 25 kHz channel bandwidth communications

• 40 MHz-wide channel tables (390 MHz–430 MHz and 430-470 MHz models)

• Provides upgrade path for existing installations

 Fast over-the-air data rate

• 19,200 bits per second

• Reduced latency provides better GNSS position information

• Shorter transmit times reduces power consumption for longer battery life

 User-selectable RF output

• Select between 0.1 W, 0.5 W, 1 W, 2 W, and 4 W

• Increase range by switching to a higher output power

• Increase battery life by reducing output power when you do not need the range

 Rugged construction

Designed specifically for real-world working environments

• All metal construction and shock-mounted electronics ensure highest reliability and 
EMI-resistance.

• Watertight, corrosion-resistant connectors stand up to bad weather conditions.

 Software compatibility

Current versions of the following software were tested and verified for compatibility with 
Windows® 7, Windows XP, and the Business Edition of the Windows Vista® operating systems:

• ADLCONF

• PCC Range Estimator
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 Configuring the Radios

 ADLCONF configuration software
ADLCONF is the software application for configuring and troubleshooting all Advanced 
Data Link (ADL) radios. Running the ADLCONF software on a computer attached 
through a serial cable to an ADL radio enables you to check the status of the radio, enter 
receive-only channel tables, and set radio parameters such as channel bandwidth and 
output power. Channel tables for transmission of data must be obtained from authorized 
Pacific Crest dealers. If your radio did not come with a channel table already installed, you 
can obtain one from your dealer and then import it using the ADLCONF software. 

The latest version is available for free download from www.PacificCrest.com. The 
ADLCONF User Guide is also available on the Pacific Crest website. A user guide that 
describes how to configure the ADL Sentry radio is available by running the ADLCONF 
software and then selecting Help / User Guide. 

 Factory default settings
To return the radio to its factory default configuration, use the ADLCONF software. Click 
Restore Factory to the right of the screen and then click Program. The following table 
shows the factory default settings:

Description Default Setting

Device Status Battery status

Channel/Frequency Channel No. and frequency (MHz)

Channel Tx Frequency Channel No. and frequency (MHz)

Data Protocol Transparent EOT (End of Transmission)

Radio Link Rate 9600

Operation Mode (Trimble protocol) Base/Rover

Sensitivity High (Rover)

Rx LED Meaning Signal Received

Serial Baud 38000

Advanced Menus Hide

CSMA On

Security Code Off

Edit Configuration Enabled

Scrambling On

Forward Error Correction On
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Setup in the Office

  1. Plug the radio’s desktop power supply into the wall. You may alternatively use an approved   
   12 Volt battery for power. But you must never power a radio with a battery while it is being    
    recharged.  Th is will damage the battery.
  2. Attach the desktop power supply’s (or battery’s) SAE connector to the radio programming   
   cable’s SAE connector.
  3. Attach the programming cable’s DE-9 connector into a serial port on your PC.  If your PC   
   does not have a serial port, you should use a serial-to-USB adaptor.
  4. Attach the programming cable’s Turck plug (with the red dot facing up) into the bottom of   
   the radio.  Th is will turn the radio on.
  5. Install ADLCONF, available for free download from http://www.pacifi ccrest.com/support.  
   php?page=updates.
  6. Launch ADLCONF and refer to its user guide for instructions on connecting to ADL radios.   
   Th e user guide is displayed when you click Help > User Guide on ADLCONF’s main menu.    
   In most  cases, you simply click the Connect button on the right of the ADLCONF main   
   screen.
  7. After connecting to the radio for the fi rst time you should click File > Export and save a   
   copy of  the radio’s original confi guration to your PC.  You also can return the radio to its   
   factory confi guration by clicking File > Import and selecting this fi le.  You will not lose any   
   channel tables or personalized confi gurations such as Owner Name or Call Sign by

    importing a confi guration fi le.

ADL Sentry Setup



13 ADL Sentry User Guide

Setting up in the Field

  1. Attach the antenna to the radio, either directly to the top of the radio or to an antenna cable. 
  2. Attach the radio to your tripod using the tripod clip on the back of the radio. See the fi gure be 
   low for setup suggestions.
  3. Connect the radio to the source of the data you will transmit, for example, a GPS receiver, using  
   the data/power cable. Th e ADL Sentry  radio uses the same data connector – with the same pin 
   outs - found on the PDL HPB radio. Th is makes the radios  compatible with existing HPB data  
   cables.
  4. Join the data/power cable’s SAE connector to the 12 Volt battery’s SAE connector.  Th is will turn  
   the radio on.  If the radio had previously been powered on and then off , turn it on again by 
   pressing the On/Off  button in the center of the front panel. 
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Wall Mounting Kit (PN K01134)

Before connecting any cables, attach the ADL Sentry wall mount onto the back of the raido 
and then attach the wall mount to the wall

Mast Mounting Kit (PN K01135)

Alternatively attach the ADL Sentry mast mount onto the back of the radio and then attach 
the mast mount to the antenna mast.



15 ADL Sentry User Guide

Tripod mount

Each ADL Sentry radio includes a tripod clip on the rear of the radio. Insert the clip into a 
slot on the tripod:

 Antenna and antenna mount

The most important activity in setting up a radio transmitter is determining the placement 
and type of the antenna.  Where flexibility permits, always place the antenna on the highest 
point available and always select an antenna with a gain pattern (more on this later) which 
optimizes the coverage.  In general, use a directional gained antenna such as a Yagi for a 
point-to-point fixed location application and a gained omnidirectional antenna for mobile 
point-to-point or point-to-multipoint communication systems.

Note –Safety Concerns

 - Be aware of power lines or other obstacles that can inadvertently come in contact with the 
antenna and cause potentially lethal conditions.

 - Guy-wire antenna masts higher than 10 feet.

 - Use lightning arrestors for equipment and personal protection if erecting an antenna in 
areas prone to lightning.

 - Installation of antennas on buildings or other structures (towers, etc.) must be done in 
accordance with local building regulations. Contact a local antenna installer who is familiar 
with building codes and proper antenna installation for any permanent installation.
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If you have an antenna with a male TNC connector, you can attach it directly to the RF 
connector on the top of the radio. We highly recommend, however, that you elevate the 
RF antenna as much as possible. The most common set up is similar to that shown in the 
following illustration where an antenna cable with male TNC connector is attached to the 
radio. The other end of this cable is attached to a tripod or elevated section of range pole. 
The RF antenna is then attached to the end of the cable. Pacific Crest offers an antenna 
cable that attaches to standard 5/8-in threaded tripods and range poles and antennas with 
NMO connectors.

Inspect the antenna center push-pin contact to ensure that it makes good contact with 
the antenna mount. A good antenna connection is critical to system performance. 

Note – Always ensure that an antenna is connected before transmitting with any radio. A 
good field practice is to attach the antenna before you turn on the radio and then turn off the 
radio before you detach the antenna. Using a gained antenna raises the Effective Isotropic 
Radiated Power (EIRP) of the radio. Ensure that the resultant EIRP does not exceed your 
licensed limit.
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 Data/Power cable

The radio is connected to a data source using a data/power cable (see below). This cable 
is available with different connectors for attaching to a large variety of data sources. 
Contact your sales representative for selecting the best cable to meet your needs:

Each data/power cable also connects the radio (and in some cases, the data source) to 
external power through an SAE-type connector. Pacific Crest strongly recommends you 
use the external battery, which includes an SAE connector. It is sold both separately and 
as part of the battery/charger kits.

 Serial Port

The ADL Sentry supports one full RS-232 data port on an 8-pin I/O port. This port is 
used to receive or transmit data in “data mode.” Attaching the ADL Sentry to a source of 
power and a source of data is all you need to do to put Port 1 into “data mode.” Port 1 may 
also be used in “command mode” to configure or troubleshoot the radio. To put Port 1 in 
“command mode” apply power to the radio and connect it to a PC running ADLCONF 
configuration software. Contact Pacific Crest Sales for information on incorporating into 
your own software application a set of RS-232 commands for communication with the 
ADL Sentry.

Enclosure

The radio enclosure is made from a tough, impact-resistant aluminum alloy. The 
enclosure receives an anti-corrosion treatment and is further protected with a chemical- 
and scratch-resistant polyurethane coating. Elastomer end caps provide the first level of 
shock protection for the internal components. An internal isolation system reduces the 
effects of vibration on the radio receiver board.

 Antenna connector

The integrated antenna connector provides an industry standard TNC-female RF 
connector that is compatible with a wide range of mobile whip antennas. Pacific Crest 
also sells cables that connect the radio to remote antennas.

 

 

Data Source Connector

Radio Connector

SAE Power Connector
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Battery care
The ADL Sentry Battery/Charger kit includes a 12 V, 12-AHr, battery.  The battery is deep-
cycle, deep-discharge, sealed lead-acid battery, also known as portable power batteries. 
The battery  provide all-day operation for the respective radio and can be recharged 
approximately 300 times over a period of three years if proper care is maintained. 

A deep-discharge battery will last longer if it is never fully discharged during use and 
always fully charged before storage. If the battery is discharged entirely, the capacity will 
diminish. Transmitting at a high power level for a long period of time may cause the 
battery to reach the automatic shut off level before eight hours of use and will need to be 
recharged.

If you use your own battery, select a deep-discharge battery with a minimum capacity 
of 30 AHr. If necessary, you can use an automotive battery, but it will be damaged by 
repetitive discharge/charge cycles. An automotive battery will lose capacity in just a few 
cycles. Pacific Crest does not recommend this practice. 

To protect the battery from over-discharge, an ADL Sentry  will flash a low voltage 
warning when the input voltage declines to 10 V DC. If the voltage continues to decline, 
the radio will shut itself off at 9 V DC. At 10 V DC, the LEDs on the front of the radio will 
flash twice, pause, flash twice again, pause, etc. indicating low input voltage. If a radio has 
shut itself off because of low input voltage, it will automatically turn itself back on when 
the voltage returns to 9 V DC or higher.

The 10 V warning and 9 V shut-off levels are the factory defaults. If you wish, you can use 
ADLCONF software (Radio Link - Advanced screen) to configure other power levels.   You 
can input a lower value for the ADL Sentry, but please be advised that values lower than 9 
V might permanently damage your battery.

 Charging

The charger supplied with the radio Battery/Charger kit provides two-stage charging and 
must be connected to the battery following every full day of operation to ensure good 
battery life and performance. The first stage quickly charges the battery to capacity, and 
the second stage trickle charges the battery to maintain a full charge. It is important 
to recharge your battery every time it is used. Do not allow a battery to remain in a 
discharged state any longer than necessary.

It is important to periodically charge any battery that is stored for an extended length of 
time. Storing batteries for an extended time in a discharged state damages them and will 
reduce the capacity of the battery. To recharge a user-supplied battery, select a charger 
of appropriate type. A battery charge designed for use with a deep-cycle, deep-discharge, 
sealed lead acid battery may damage an automotive battery. An automotive battery 
charger may not fully charge a deep-cycle, deed-discharge, sealed lead acid battery. Never 
recharge any battery while it is connected to a radio as it could damage the radio and/or 
the battery.
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Operating the Radio

Turning the radio on and off
To turn on the radio, attach the radio to power using either the programming cable 
(attached to wall/mains current) or the data/power cable (attached to the external 
battery of the radio). Once the radio detects power on its data connector, it automatically 
turns on and is ready for communication within 5 seconds. If the wall/mains current is 
interrupted, the radio automatically turns itself on and resumes transmitting data within 
5 seconds of power restoration. If the radio is attached to an antenna when the radio is 
turned on, it automatically runs an antenna test before it will communicate. Wait until 
this test is complete before transmitting any data.

To turn off the radio, either detach its power cable or depress the On/Off button in the 
center of the front panel for 5 seconds.. 

To turn the radio on again, either press the On/Off button or remove and reinsert the 
data/power cable.
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Indicator LEDs

LED Description

Tx Shows that the radio is broadcasting. 

In most GPS RTK applications, the Tx LED flashes approximately once per second.

Pwr Shows the power status and also provides a high and low external voltage supply 
indicator.

When lit, power is turned on. If the power is too high or too low, the LEDs will flash 
the number of the Error Code (see page 20). The PWR LED blinks when the external 
voltage drops to a level determined using ADLCONF software. (The default 
level is 10 VDC.) 

If the PWR LED does not turn on/off when pressing the On/Off button on the radio’s front 
panel, inspect the external voltage supply. The minimum voltage required by the radio is 
9 VDC.

Rx Shows that the radio is receiving signals from another radio or from a source of 
interference.

The default is Signal received, but you can reset the radio so that when its Rx LED flashes 
it means Data packets received. You can reset the meaning either through the radio or 
with the ADLCONF software. 

During normal operation, the Rx LED flashes at once per second to show reception of 
transmissions from the transmitting radio. If the Rx LED is on continuously, a source of 
interference may be affecting the radio’s ability to receive data. 

To reduce or eliminate the interference, reposition the antenna, or change to another 
channel at both the transmitter and receiver.

PGM Can be programmed to behave in user-definable ways. For more on programming contact 
your Pacific Crest dealer.

Serial Port

The ADL Sentry supports one full RS-232 data port on an 8-pin I/O port. This port is 
used to receive or transmit data in “data mode.” Attaching the ADL Sentry to a source of 
power and a source of data is all you need to do to put Port 1 into “data mode.” Port 1 may 
also be used in “command mode” to configure or troubleshoot the radio. To put Port 1 in 
“command mode” apply power to the radio and connect it to a PC running ADLCONF 
configuration software. Contact Pacific Crest Sales for information on incorporating into 
your own software application a set of RS-232 commands for communication with the 
ADL Sentry.

 Security code
You can use the ADLCONF software to configure ADL radios to send and receive 
encrypted data via the Transparent EOT/EOC or Packet Switched protocols. When 
an ADL Sentry radio is programmed for encryption and is set to one of these three 
supporting protocols, only similarly configured radios will be able to communicate with it.

Note – With the Security Code feature on, the radio will be unable to communicate with 
other radios that are not set to use the same code. When you enable this feature for one radio, 
therefore, you should enable it for all the radios in the same communication network. ADL 
radios with button/LCD interfaces can turn the Security Code feature on or off in the field, but 
all other Pacific Crest radios, such as the ADL Sentry, must be attached to a computer running 
the appropriate configuration software to disable the Security Code feature. 
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 Scrambling
To demodulate a digital transmission, a receiver must synchronize itself with the 
transmitter. This can be hard to do when the transmitter sends a long series of one’s or 
a long series of zeroes. But if every nth character in the transmission were switched, a 
one to a zero or a zero to a one, and if the receiver is expecting this, it can more quickly 
synchronize itself with the transmission. This is essentially what Scramble Control does 
and why we recommend you leave it on for all radios. However, if some of the radios in your 
system are not Pacific Crest or Trimble radios, you may need to turn Scrambling off.

Note - Trimble protocols require Scrambling. With a Trimble protocol selected, you are unable 
to turn scrambling off. 

Forward Error Correction
Forward Error Correction places extra bits in the transmitted data so receivers can check 
for transmission errors. Although data throughput is adversely affected, using Forward 
Error Correction can greatly improve range and so is strongly recommended.

Tips and Techniques for Best 
Performance

 Antenna
Antenna placement is critical for good performance. Range and coverage is directly 
proportional to the height of the transmitting and receiving antennas in addition to 
antenna gain. Where possible, select a reference station location that takes advantage of 
terrain to get the transmitting antenna as high as possible.

Always use the telescoping antenna mast and raise the antenna as high as is practical and 
safe given terrain and wind conditions.

Antennas are excellent conductors of electricity, so use extreme caution when operating 
near power lines and other sources of electric current or during stormy weather.

Do not use a gained antenna if doing so increases the radio’s Effective Isotropic Radiated 
Power beyond the limit of your license.

 Line loss
Line loss from connectors and cables between the radio and antenna decreases the output 
power transmitted by the antenna, thereby decreasing the signal’s range. To minimize line 
loss, please check the loss-per-length of cable to be used. For every 3 dB of line loss, the ERP 
(Effective Radiated Power) decreases by half. For example, if you have a 4 W radio and a line 
loss of 3 dB in your cable and antenna, the power effectively radiating from the antenna is 2 
W. Every 6 dB of loss reduces the radio’s effective range by 50%.
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  Power supplies
Maintain batteries in a fully charged state. They last longer if they are do not become 
completely discharged. We recommend routinely connecting the battery to its charger 
after every working day and for 24 hours every three months during period of non-use. 
This ensures optimal performance and long battery life.

 Equipment care
Routine equipment care prolongs the life and reliability of your radio. Radio 
communication equipment is susceptible to damage from shock or environmental 
extremes. Never operate the radio outside the operating specifications contained in 
“Safety Information” on page 3.

 Use with Machinery and Vehicles

 Vibration damping
ADL Sentry radio meet or exceed the MIL-STD 810F standard for vibration (up to 2.6 g). 
It is always recommended to mount the radio with rubber dampers. Avoid introducing 
vibration and tension into the data/power connector at bottom of radio. Consider 
supporting the data/power cable with a rubber-padded clamp.

 Mounting inside/outside vehicle cabin
The radios are rated IP67 and can be mounted outside a cabin.  However, the radios 
automatically turn off if the temperature inside the radio exceeds 80 °C (140 °F), so it is 
best to avoid direct sunlight in very hot environments. Installing all electronic devices 
inside an air-conditioned cabin is always better.

 DC power supply with power conditioner 
The radios require 9 to 30 V DC at all times. Voltage spikes over 30 volts can damage the 
radio and voltage transients can affect performance. The ideal power supply is 13.5 V DC 
and 3 to 5 amps for ADL Sentry radio. Vehicle installations must always include a suitable 
power conditioner.
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 Protection from electromagnetic interference
Always position the radio as far as possible away from:

• Other antennas, particularly transmitting antennas

• Electrical generators/alternators

• Regulated power supplies

• Rotating beacons, strobe lights

 Pinouts and Connectors
The radio uses a Turck 8-pin circular data/power connector. For a mating connector, 
Pacific Crest recommends using a Turck RSS 8T, or equivalent. 

The following table shows the radio’s  pin assignments:

Pin No. Description

1 Signal Ground

2 Power Ground

3 Tx (Connects to the external device’s Rx pin)

4 RX (Connects to the external device’s Tx pin)

5 RTS

6 N/C

7 CTS

8 9-30 VOLTS, 2 AMP Max

The following figure shows the orientation of the pins in the radio’s female data/power 
connector. It shows a rear view of the pin-outs (looking from behind the connector).
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ADL Sentry Data Cable DE9 Connector

The ADL Sentry offers cables to cnnect to external devices via a DE9 connector.

ADL Sentry Data Cable’s DE9 Pin Assignments

Pin No. Description

1 N/C

2 RX

3 TX

4 N/C

5 Signal Ground

6 N/C

7 RTS

8 CTS

9 Data Cable

ADL Sentry SAE Power Connector Polarity

The ADL Sentry uses an SAE-type power connector. The following figure shows the 
polarity of the SAE-type connector.
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Antenna
All Pacific Crest ADL radios use a TNC female antenna connector. While you may attach 
an antenna directly to the radio, range will be greatly improved if you elevate the antenna 
as high as possible. Pacific Crest makes antenna cables in a variety of lengths. These 
terminate in industry-standard NMO or N-type connectors. If you wish to use your own 
antenna cable, we recommend Amphenol-brand connectors. You should also use only 
high-quality, 50-Ohm impedance cabling. 

Connector manufacturer contacts

• Contact Turck at www.turck.com

• Contact Amphenol at www.amphenol.com
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 Technical Specifications
General Specifications

   Communication 1 RS-232 port, 115.2 kbps maximum

   User Interface 2-row, 16-character LCD display with five navigation buttons

Power

   Input Power 9.0 V DC – 30.0 V DC, 2 amp maximum

At 9 V DC, the current must not exceed 15 amps at any time.

Warning – Supplying 30.0 V DC or more than the specified 
current can damage the radio.

   Power Consumption (Rx) 0.6 W nominal @ 12.0 V DC

   Power Consumption (Tx) 7 W nominal @ 12.0 V DC, 1 W RF output 13.4 W nominal @ 12.0 
V DC, 4 W RF output

Modem Specifications

   Modulation/Link Rates GMSK: 4800, 8000, 9600, 16000, 19,200 bps

4FSK: 9600, 19,200 bps

   Link Protocols Transparent FST/EOT/EOC, Packet-switched, TRIMTALK™, 
TRIMMARK™, TT450S (HW), SATEL® 

   Forward Error Correction Yes

Radio Specifications

   Frequency Bands 390 to 430 MHz and 430 to 470 MHz

   Frequency Control Synthesized 6.25 kHz tuning resolution

Frequency stability: ±1 PPM -40 ˚C to +85 ˚C

   Channel Bandwidth 12.5 kHz and 25 kHz, software derived

   RF Transmitter Output Programmable to 0.1 – 4 Watts (where permitted)

   Sensitivity –110 dBm BER 105

   Type Certification Type accepted and certified for operation in the U.S., Europe, 
Australia, Russia, New Zealand, and Canada.

Environmental Specifications

   Enclosure IP67 (Dustproof and watertight to depth of
1 m for 30 minutes)

   Operating Temperature (Receiver) –40 ˚C to +85 ˚C (–40 ˚F to +185 ˚F)

   Operating Temperature
   (Transmitter)

–40 ˚C to +65 ˚C (–40˚ F to +149 ˚F)

   Storage Temperature (Receiver/
   Transmitter)

–55 ˚C to +85 ˚C (–67 ˚F to +185 ˚F)

   Vibration Spec MIL-STD-810F

Mechanical Specifications

   Dimensions  8.89 cm L x 4.6 cm W x 16.0 cm H
(3.5 in L x 1.809 in W x 6.3 in H)

   Weight 690 grams (1.52 lbs.)

   Data/Power Connector 8-pin Turck RSS 8T

   RF Connector 50 Ohm, TNC-female


